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Warranty 

All products manufactured by ICP DAS are under warranty 
regarding defective materials for a period of one year, beginning 
from the date of delivery to the original purchaser. 

Warning 

ICP DAS assumes no liability for any damage resulting from the 
use of this product. ICP DAS reserves the right to change this 
manual at any time without notice. The information furnished by 
ICP DAS is believed to be accurate and reliable. However, no 
responsibility is assumed by ICP DAS for its use, not for any 
infringements of patents or other rights of third parties resulting 
from its use. 

Copyright 

Copyright @ 2013 by ICP DAS Co., Ltd. All rights are reserved. 

Trademark 

The names used for identification only may be registered 
trademarks of their respective companies. 

 

Contact US 
 

If you have any problem, please feel free to contact us. 
You can count on us for quick response. 
 
   Email: service@icpdas.com 

 

mailto:service@icpdas.com
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1.  Introduction 

WinPAC-8000 is the second generation PAC of ICPDAS. It equips a PXA270 CPU (520 
MHz) running a Windows CE.NET 5.0 operating system, various connections (VGA, USB, 
Ethernet, RS-232/485) and 1/4/8 slots for high performance parallel I/O modules (high 
profile I-8K series) and serial-type I/O modules (high profile I-87K I/O modules).  
 
Its operating system, Windows CE 5.0, has many advantages, including hard real-time 
capability, small core size, fast boot speed, interrupt handling at a deeper level, 
achievable deterministic control and low cost. Using Windows CE.Net 5.0 in the 
WinPAC-8000 gives it the ability to run PC-based Control software such as Visual 
Basic.NET, Visual C#, Embedded Visual C++, SCADA software, Soft PLC …etc.  
 
Comparing with the first generation WinCon-8000, it not only improves the CPU 
performance (from 206 MHz to 520 MHz) and upgrading OS (from CE 4.1 to CE 5.0), but 
also adds many reliability features, such as dual LAN, redundant power input, dual 
battery backup SRAM, etc. It gives you all of the best features of both traditional PLCs 
and Windows capable PCs.  
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1.1.  Features 

 

Windows CE .Net 5.0 Inside 
Most of the popular features in MS software are included, such as 

1. FTP Server 
2. HTTP Server 
3. ASP (Java script, VB script) 
4. SQL Server Compact Edition 3.5 
5. Compact .Net Framework 3.5 

Remote Maintenance via FTP Server and VCEP Software 
The FTP server is used for uploading applications or downloading data. And VCEP is 
designed for managing the WinPAC-8000. VCEP can synchronize every movement 
(screen, keyboard and mouse actions) between the PC and the WinPAC-8000 via the 
Ethernet. By using the FTP server and VCEP, you can update and manage the 
WinPAC-8000 remotely via the Ethernet. 

Built-In OPC Server 
NAPOPC_CE5 is an OPC server and SCADA software can easily integrate I/O modules 
through it. Furthermore, it also provides a library which users can use to develop their 
AP by eVC, C# or VB.Net. 

NAPOPC_CE5 not only supports I/O modules in local slots, but also supports remote 
I/O modules with the following protocols via the RS-232/485 or Ethernet: 

1. Modbus/RTU 
2. Modbus/ASCII 
3. Modbus/TCP 
4. DCON 
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Rich Software Solutions 
 

 
 

On the WinPAC-8000, ICP DAS provides the following software solutions to fit in 
different applications. 

1. Visual Studio .Net 2003/2005/2008 and eVC solution: 
SDK as well as demo programs for C#, VB.Net and eVC are provided. 

2. SoftPLC solution: 
A. ISaGRAF supports IEC61131-3 languages, Ladder Diagram (LD), Structured Text 

(ST), Function Block Diagram (FBD), Sequential Function Chart (SFC), Instruction 
List (IL), and Flow Chart (FC). 

B. KW-software supports IEC61131-3 languages and HMI features. 

3. SCADA solution:  
Indusoft provides simple “drag and drop”, “point and click” developing environment 
for HMI and SCADA applications. 
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Upgrading applications from WinCon to WinPAC just copy and play 
 

 
Users can upgrade their controller from WinCon-8000 to WinPAC-8000, and meanwhile 
still keep most of their old applications (.exe file) running smoothly on WinPAC-8000 
without any modification. The only thing that users have to do is just to copy the .exe file 
from WinCon-8000, paste it to WinPAC-8000, and then play it. How simple it is. And for 
exceptions that old applications (.exe file) are not able to follow the copy-and-paste rule, 
users can still finish the upgrading by recompiling the old applications. 
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Power CPU Module 
The most important features of the CPU module are 

1. PXA270 or compatible CPU (32-bit and 520MHz) 
2. 128 MB SDRAM 
3. 63 MB Built-In Flash Disk (WP-8x3x) 

31 MB Built-In Flash Disk (WP-8x4x) 

Built-in VGA Port 
A built-in VGA port can be directly connected to a regular LCD display. Users can 
operate the HMI or SCADA software (running on the WinPAC-8000) with display, 
keyboard and mouse just as how they usually did on regular PCs.  

64-bit Hardware Serial Number 
The 64-bit hardware serial number is unique and individual. Every serial number of 
WinPAC-8000 is different. Users can add a checking mechanism to their AP to prevent 
software from pirating. 

Rich I/O Expansion Ability (RS-232/485, Ethernet, FRnet, CAN) 
Beside the local I/O slots, WinPAC-8000 also equips several RS-232/485 ports, two 
Ethernet ports to connect serial I/O and Ethernet I/O. And with FRnet and CAN 
communication module in local slot, FRnet I/O and CAN devices are easy to be 
integrated.  

Built-In Flash Disk (31/63 MB) 
In normal situation, users can store their AP or data to the Micro SD card or USB Flash 
disk. But in some vibrational environment (for example, like driving ships), the two 
storage media would be bad connection. Then the built-in Flash disk will be the best 
storage media in such the vibrational environment. 

Dual Watchdog Timer 
A system could be hanged up when the OS or the AP fails. There are two watchdogs 
(OS watchdog and AP watchdog) designed to automatically reset the CPU when the 
situations happen. The design will increase the reliability of the system. 
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Dual Battery-Backup SRAM (512 KB) 
To maintain important data while power off, non-volatile memory is the ideal design. The 
WinPAC-8000 equips a 512 KB SRAM with two Li-batteries to maintain data while 
power off. 

The two Li-batteries can continually supply power to the 512 KB SRAM to retain the 
data for 5 years; and the dual-battery design can avoid data lost while replacing a new 
battery. 

Dual Ethernet Ports 
WinPAC-8000 provides two Ethernet ports. The two Ethernet ports can be used to 
implement redundant Ethernet communication and separate Ethernet communication 
(one for global Internet, one for private Ethernet). 

Redundant Power Input 
To prevent the WinPAC-8000 from failing by the power loss, the power module is 
designed with two input connectors. Once a power input fails, the power module 
switches to the other power input. And there is a relay output for informing the power 
failure. 

Ventilated Housing Design Allows Operation Between -25 ~ +75 ˚C 
Each WinPAC-8000 is housed in a plastic-based box with a column-like ventilator that 
can help to cool the working environment inside the box and allow the WinPAC-8000 
operating between -25 ˚C and +75 ˚C 
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I/O expansion 

 
WinPAC-8000 provides the following I/O expansion bus 

Local I/O Slot 
There are 1/4/8 slot options to expand local I/O. And the I/O modules can be parallel bus 
type (high profile I-8K series) and serial bus type (high profile I-87K series).  
 
The differences between I-8K and I-87K are listed below: 

Item I-8K Series I-87K Series 
Microprocessor No Yes (8051) 

Communication interface Parallel bus Serial bus 

Communication speed Fast Slow 

DI latched function No Yes 

Counter input (for digital input module) No Yes (100 Hz) 

Power on value No Yes 

Safe value No Yes 

Programmable slew-rate for AO module No Yes 
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Ethernet 
The available Ethernet I/O devices are ET-6000, ET-7000, I-8KE4/8 and 
I-8KE4/8-MTCP.  

WinPAC-8000 can access them with Modbus/TCP or DCON protocol. 

RS-485 
WinPAC-8000 is equipped with two RS485 COM ports which enable the transmission 
rate up to a maximum of 115.2 Kbps. The medium for connection is a twisted-pair, 
multi-drop, 2-wire RS-485 network that can link i-7000, M-7000, RU-87Pn and high 
profile I-87K modules. 

FRnet 
FRnet is an innovative industrial field bus that has many special features, such as 
high-speed deterministic I/O control, real I/O synchronization capabilities, non-protocol 
communication, and easy programming. Plugging in an FRnet communication module 
(I-8172W), the WinPAC-8000 can link FRnet I/O modules to implement high-speed 
distributed I/O.  

CAN Bus 
The Controller Area Network (CAN) is a serial communication way, which efficiently 
supports distributed real-time control with a very high level of security. It provides the 
error-processing mechanisms and concepts of message priority. These features can 
improve the network reliability and transmission efficiency. Furthermore, CAN supplies 
the multi-master capabilities, and is especially suited for networking “intelligent” devices 
as well as sensors and actuators within a system or a sub-system. With I-8120, I-8123, 
I-8124, I-87120, I-87123, and I-87124, WinPAC-8000 is able to demonstrate every 
feature of CAN, CANopen, and DeviceNet. 
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1.2.  Specifications 

System Software 
OS WinCE.Net 5.0 

.Net Compact Framework 3.5 

Embedded Service FTP server, Web server (supports VB script, JAVA 

script), Embedded SQL server 

SDK Provided Dll for eVC, Dll for Visual Studio.Net 2003/2005/2008 
 
 

CPU Module 

CPU PXA 270 or compatible (32-bit and 520 MHz) 

SDRAM 128 MB 

Dual Battery Backup SRAM 512 KB (for 5 years data retain) 

Flash 

WP-8431/ WP-8831 : 

 

WP-8441/ WP-8831: 

 

128 MB (64 MB for OS image, 63 MB for built-in Flash 

disk, 1 MB for registry) 

96 MB (64 MB for OS image, 31 MB for built-in Flash 

disk, 1 MB for registry) 

Expansion Flash Memory Micro SD socket with a microSD card (can support 

16GB microSD card) 

RTC (Real Time Clock) Year-2000 compliance; seconds, minutes, hours, date 

of the month; month, year, valid up from 1980 to 2079 

EEPROM 16 KB (0 ~ 8 KB for user, 9 ~ 14 KB for other 

programs, 15 ~ 16 KB for OS), Data Retention: 40 

years; 1,000,000 erase/write cycles 

64-bit Hardware Serial Number Yes 

Dual Watchdog Timer Yes 

Programmable LED Indicator 1 

Rotary Switch Yes (0 ~ 9) 

DIP Switch Yes (8 bits); for WP-8431, WP-8441, WP-8831 and 

WP-8841 only 
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Power 
Input Range +10 ~ +30 VDC 

Isolation 1 kV 

Redundant Power Inputs Yes, with one power relay (1 A @ 24 VDC) for alarm 

Capacity WP-8131 and WP-8141:  

1.0 A, 5 V supply to CPU and backplane, 0.6 A, 5 V supply 

to I/O expansion slots, total 30 W 

WP-8431 and WP-8441:  

1.1 A, 5 V supply to CPU and backplane, 4.9 A, 5 V supply 

to I/O expansion slots, total 30 W 

WP-8831 and WP-8841:  

1.2 A, 5V supply to CPU and backplane, 4.8 A, 5 V supply to 

I/O expansion slots, total 30 W 

Consumption WP-8131 and WP-8141: 7.3 W (0.3 A @ 24 V) 

WP-8431 and WP-8441: 9.1 W (0.38 A @ 24 V) 

WP-8831 and WP-8841: 9.6 W (0.4 A @ 24 V) 

 
 

VGA & Communication Ports 

VGA WP-8x3x: 

Yes, with one extra GPU  

(resolution: 1024 x 768, 800 x 600, 640 x 480) 

WP-8x4x: 

Yes (640 x 480, 800 x 600 resolution) 

Ethernet Port RJ-45 x 2, 10/100 Base-TX 

(Auto-negotiating, LED indicators) 

USB 1.1 (host) WP-8x3x: 2 

WP-8x4x: 1 

COM0 (Internal RS-485 interface communication with I-87K I/O 

modules in slots) Note: CPU internal UART 

Baud Rate – 115200 bps 
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VGA & Communication Ports 

Data Bits – 8 

Parity – None, Even, Odd 

Stop Bits – 1 

FIFO – 1 byte  

COM1 (RS-232 used to update firmware) Note: CPU internal UART 

Baud Rate – 115200, 57600, 38400, 19200, 9600, 4800, 2400, 

1200 bps 

Data Bits – 7, 8 

Parity – None, Even, Odd 

Stop Bits – 1 

FIFO – 1 byte  

COM2 (RS-485) Note: 16C550 compatible 

Baud Rate – 115200, 57600, 38400, 19200, 9600, 4800, 2400, 

1200 bps  

Data Bits – 5, 6, 7, 8 

Parity – None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits – 1, 2 

FIFO – 16 bytes 

COM3 (RS-232/RS-485), for WP-8431, WP-8441, WP-8831 and 

WP-8841 only 

Note: 16C550 compatible 

Baud Rate – 115200, 57600, 38400, 19200, 9600, 4800, 2400, 

1200 bps  

Data Bits – 5, 6, 7, 8 

Parity – None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits – 1, 2 

FIFO – 16 bytes 

Tips & Warnings 

COM3 can be configured as either RS-232 or 

RS-485, that only can select one at a time and Its 
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VGA & Communication Ports 

configuration depends on the pin connections as 

follows: 

RS-232 (RXD, TXD, CTS, RTS and GND) 

RS-485 (Data+ and Data-) 

There is no software configuration or hardware 

jumper needed. 

 

COM4 (RS-232), for WP-8431, WP-8441, WP-8831 and WP-8841 

only, Note: 16C550 compatible 

Baud Rate – 115200, 57600, 38400, 19200, 9600, 4800, 2400, 

1200 bps  

Data Bits – 5, 6, 7, 8 

Parity – None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits – 1, 2 

FIFO – 16 bytes 

 
 

I/O Expansion Slot Number 

Supports high profile I-8K and I-87K modules only 

WP-8131/ WP-8141 1 Slot 

WP-8431/ WP-8441 4 Slots 

WP8831/ WP-8841 8 Slots 

 

Dimensions 
WP-8131/ WP-8141 95 x 132 x 111 mm 

WP-8431/ WP-8441 230 x 132 x 111 mm 

WP-8831/ WP-8841 355 x 132 x 111 mm 
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Operating Environment 

Operating Temperature –25°C ~ +75°C 

Storage Temperature –30°C ~ +80°C 

Humidity 10 ~ 90%, Non-condensing 
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1.3.  Dimensions 

There are several series of WinPAC modules whose overviews depended on the 
quantity of the slot.  
All dimensions in millimeter.  
 

1 Slot 

 

Top View 

 

Front View 

 

 

 

Right Side View 

 

Left Side View 
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4 Slots 
 
Top View 

 

 
Front View 

 

Right Side View 
 

Left Side View 
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8 Slots 
 
Top View 

 

 
Front View 

 

 
Right Side View 
 

 
Left Side View 
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1.4.  Overview 

The WinPAC contains several interfaces and peripherals that can be integrated with 
external systems. Here is an overview of the components and its descriptions. The 
details of these items are as follows: 
 
 
 
 

WP-8131 
 
 
 
 
 
 
 
 
 
 
 
 
 

WP-8141 
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WP-8431/WP-8831 
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WP-8441/WP-8841 
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1. LED Indicators 
The WinPAC has two LED indicators that are located near the rotary 

switch and show the operation status. 

 

 
 

2. Rotary Switch 
 

The Rotary Switch is an operating mode selector switch which provides 
seven functions related to the selection of the operating mode and 
authorization control for the WinPAC. 

For more information about the operating mode, please refer to “section 2.3. 
Configuring the Boot Mode” 

3. Micro SD Socket 
There is a Micro SD expansion slot which is used to increase memory capacity just in 
case 16 GB. 

4. VGA Connector 
The VGA connector is a 3-row 15-pin connector that can be used to 
connect a monitor at a variety of supported VGA resolutions. These 

resolutions range from 640 x 400 to 1280 x 1024. 

 

LED Indicator State (Color) Meaning 
RUN ON (Red) The OS is ON 
 Blinking The System_disk formatted 

or defragmented 
PWR ON (Green) The Power is ON 
 OFF The Power is OFF 
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5. I/O Expansion Slot 
The WinPAC includes some additional I/O slots that can be used for expansion 
purposes. The number of expansion I/O slots for each model is as follows:  
WP-8141/WP-8131: 1 I/O slot 
WP-8441/WP-8341: 4 I/O slots 
WP-8841/WP-8831: 8 I/O slots 

6. Connector 
The connector has 10 pins and the pin assignments are as follows: 

 

WP-8131/WP-8141 WP-8431/WP-8441/WP-8831/WP-8841 

Signal Description Signal Description 

 COM2 
(RS-485) 

 
Power input 1 

  

 
COM1 
(RS-232) 

 
Power input 2 

  

  
Relay output 

 
Relay Output 

 

  
COM2: RS-485 

 
Power Input 2 

 

  
Frame Ground 

 
Power Input 1 

 

   

 
Frame Ground 

  

   

 
 
 
 
 



 

WinPAC 8000 User Manual, version 2.0.9   Last Revised: January 2014   Page: 29 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved.  ∗ E-mail: service@icpdas.com 

 

 

COM1 (3-Pins RS-232) (for WP-8131/WP-8141 only) 

Note: CPU internal UART 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd 

Stop Bits: 1 

FIFO: 1 byte 

 

COM2 (2-Pins RS-485) (WP-8431/WP-8441/WP-8831/WP-8841 
only) 

Note: 16C550 compatible 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 
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7. Ethernet Port (LAN1/LAN2) 
The WinPAC contains two Ethernet ports for use with network devices, and are denoted 
as LAN1 and LAN2.  

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

Each Ethernet port has two LED indicators, which are used to indicate the network 
speed and Link/Acting, as described below. 

 
LED Indicator State (Color) Meaning 
10/100M ON (Orange) Network Speed: 100 MB 
 OFF Network Speed: 10 MB 
Link/Act ON (Green) The Link is active 
 OFF The Link is inactive 
 Blinking(Green) Network activity 
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8. USB Port 
The WinPAC contains 1/2 USB port(s) that allow support for USB devices such as 
mouse, keyboard or an external USB hard drive.  

 

 

 

 

 

 

 

 

 

 

 

 
 

9. COM1  (WP-8431/WP-8441/WP-8831/WP-8841 only) 

Port Type: Female 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 
2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd 

Stop Bits: 1 

FIFO: 1 byte 
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10. COM3 (RS-232/RS-485) 
Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

 

COM3 can be configured as either RS-232 or RS-485, but only one 
mode can be selected at a time and the configuration depends on 
the pin connections as described below. 

RS-232 (RXD, TXD, CTS, RTS and GND) 

RS-485 (Data+ and Data-) 

No software configuration or hardware jumpers are needed. 

 

11. COM4 (RS-232) 
Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 
4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), 
Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 
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Tips & Warnings 

 The table below shows the data bit of each COM port and their corresponding 
stop bit. 

Word Length Number of Stop Bits 
5, 6, 7, 8 1 
5 1.5 
6, 7, 8 2 

 

12. DIP Switch (8 bits) 
The DIP switch can be used to set the Module 
ID to a number from 0 to 255. Do not use 
Module ID 0 for communication. 
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1.5.  Companion CD 

This package comes with a CD that provides drivers, software utility, all of the required 
documentations…, etc. All of them are listed below.  
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1.6.  Comparison of WinPAC and WinCon 

WP-8x3x/WP-8x4x  
WP-8x3x/WP-8x4x is the second generation of PAC. It is equipped with various 
connections (VGA, USB, Ethernet, RS-232/485) and 1/4/8 slots for high performance 
parallel I/O modules (high profile I-8K series) and serial-type I/O modules (high profile 
I-87K I/O modules). Comparing to the first generation WinCon PAC, it not only improves 
the CPU performance (from 206 MHz to 520 MHz), but also add many reliability 
features. 
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W-8x3x (Phased Out Since 2008)  
W-8x3x is a PAC equipped with PC interface and 3/7 slots for I/O modules. Its PC-like 
interface includes: PS/2(keyboard and mouse), VGA port , USB port and 
RS-232/RS-485 communication ports. The powerful backplane(3/7 slots) can adopts 
versatile ICPDAS's high performance parallel (I-8K I/O modules) and serial-type I/O 
modules(I-87K I/O modules) 
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W-8x4x  
WinCon-8x4x series embedded controllers are derived from existing WinCon-8x3x 
series. This evolution includes dual USB host ports to support more connectivity to USB 
I/O devices, dual Ethernet 10/100M ports to provide higher network performance, 
network security, and redundancy capability, and a rotate switch to configure your 
system and applications. 
 

 
 

 WP-8x3x WP-8x4x W-8x3x W-8x4x 

OS Windows CE 5.0 Windows CE 5.0 Windows CE 4.1 Windows CE 4.1 

CPU 520 MHz 520 MHz 206 MHz 206 MHz 

SDRAM 128 MB 128 MB 64 MB 64 MB 

Dual Battery 

Backup SRAM 

512 KB 512 KB - - 
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 WP-8x3x WP-8x4x W-8x3x W-8x4x 

Flash 128 MB (64 MB 

for OS image, 63 

MB for built-in 

Flash disk, 1 MB 

for registry) 

96 MB (64 MB for 

OS image, 31 

MB for built-in 

Flash disk, 1 MB 

for registry) 

32 MB (for OS 

image only) 

32 MB (for OS 

image only) 

EEPROM 16 KB 16 KB 16 KB 16 KB 

Expansion 

Memory Slot  

Micro SD slot  

(Default=1GB) 

Micro SD slot  

(Default=1GB) 

Compact Flash 

type II 

(Default=1GB) 

Compact Flash 

type II 

(Default=1GB) 

Interface USB1.1 x 2 

VGA port x 1  

(1024 x 768, 

640 x 480, 800 

x 600) 

USB1.1 x 1 

VGA port x 1  

(640 x 480, 800 x 

600) 

USB1.1 x 1 

PS/2 port x 2  

(Keyboard and 

Mouse),  

VGA port x 1 

(320 x 240 ~ 

1024 x 768) 

USB1.1 x 2 

VGA port x 1   

(320 x 240 ~ 

1024 x 768) 

 

Ethernet Port RJ45 x 2,  

10/100 BaseTX 

RJ45 x 2,  

10/100 BaseTX 

RJ45 x1,  

10BaseT 

RJ45 x 2,  

10/100 BaseTX 

COM0 For I-87K module 

in I/O slot 

For I-87K module 

in I/O slot 

- - 

COM1 RS-232  RS-232 For I-87K module 

in I/O slot 

For I-87K module 

in I/O slot 

COM2 RS-485 RS-485 RS-232 RS-232 

COM3 RS-232/485 RS-232/485 RS-485 RS-485 

COM4 RS-232 RS-232 - - 

I/O Expansion 

Slots 

1/4/8 1/4/8 0/3/7 0/3/7 

64-bit Hardware 

Serial Number 

Yes Yes Yes Yes 

Push button - - Yes (for Reset) Yes (For Reset) 
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 WP-8x3x WP-8x4x W-8x3x W-8x4x 

Programmable 

LED 

1 1 - - 

Dual Watchdog 

Timer 

Yes Yes Yes Yes 

Real Time Clock Yes Yes Yes Yes 

DIP Switch (8 bit) Yes  Yes - - 

Rotary Switch Yes (0~9) Yes (0~9) - Yes (0~F) 
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2.  Getting Started 

This chapter describes installation, basic configuration and fundamental operating 
principle needed to install and set up the WinPAC. 
 
 
2.1.  Mounting the Hardware 

Step 1: Mounting the WinPAC  

 
The WinPAC installation must provide proper ventilation, spacing, and grounding to 
ensure the equipment will operate as specified. 

A minimum clearance of 50mm between the WinPAC and the top and bottom side of the 
enclosure panels must be provided. 
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Step 2: Connecting power and I/O device 
 

The diagram below shows the connections of the 1 slot of the WinPAC. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The diagram below shows the connections of 4/8 slots module of the 
WinPAC. 
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2.2.  Inserting I/O Modules 

The I/O slots support parallel bus type (high profile I-8K series) and serial bus 
type (high profile I-87K series) I/O modules. There are more than 60 kinds 
of module for AI, AO, DI, AO, counter input, frequency input, PWM output, 
motion control, memory, communication, etc. 
 
 
 
 
For more 
information about 
expansion module that 
are compatible with the 
WinPAC, please refer to  
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 
 
 
 

Tips & Warnings 

It is recommended that the power to the WINPAC-8000 is switched off 
when wring the I/O module which are plugging in the WINPAC-8000 

slots. 

 
 
 
 
 
 
 
 

Step 1: Read the relevant documentation 

 

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
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The documentation for I-8K series modules is located at:   
CD:\ Napdos\io_module 
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 
 
The documentation for I-87K series modules is located at:  
CD:\ Napdos\io_module 
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 2: Wiring Connections 

All documents include the I/O module specifications, pin assignments and wiring 
connections. 
 
For example, Pin Assignments and Wiring connections for the I-87054W module are as 
follows:  

http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
http://www.icpdas.com/products/PAC/winpac/io_support_list.htm
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Pin Assignments 

Wire Connection 
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2.3.  Configuring the Boot Mode 

The WinPAC has five operating modes that can be determined through a rotary switch. 
 
The table below lists the operation mode selection. 
 

 Rotary switch position Modes of operation 
0 Normal mode (Default) 
1 Safe mode 
2 Debug mode 
3 OS update mode 
4 Development mode 
5 DCON_CE 
6 VCEP 
7 ~ 9 (For user) 

 
 
Normal mode (Default)  
Normal mode is the default mode of operation and the one you will use most of the time. 
Use this mode for more tasks and configurations. Programs also are executed in this 
mode. 
 
 
Safe mode  
Safe mode is a trouble shooting. The mode loads the minimum required device drivers 
and system services to boot the WinPAC.  
If you have malicious software or a program caused the WinPAC cannot be boot or run 
the normal mode, you can boot in safe mode to solve the problem. 
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Tips & Warnings 

In normal mode, if the new settings are not saved when you change and 
save the settings using the WinPAC Utility, to solve this problem, 

perform the following steps: 
 

Step 1: Restart the WinPAC in safe mode 
 

Turn the rotary switch to “1”, and then restart the WinPAC. 
 
 
 
 

Step 2: Start the WinPAC Utility to 
restore the default settings 

 
Start the WinPAC Utility, and then click the 

“Restore Default Settings” 
command and “Save” command 
from the “File” menu 
  
 

Step 3: Restart the WinPAC in 
normal mode 
 
Turn the rotary switch to “0”, and 
then restart the WinPAC. 
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Debug mode  
Debug mode is a special environment in which program debug functions can be used in 
addition to normal system functions. 
Debug mode is unsupported. 
 
 
OS Update mode  
OS update mode is a way used to update OS. To update the WinPAC OS image, please 
refer to “6.1. OS updates” 
 
 
DCON_CE mode  
This mode is the same as Normal mode. Besides, DCON_CE.exe will be run 
automatically after booting 
 

Tips & Warnings 

DCON_CE.exe must be placed on the \System_Disk\Tools\DCON_CE, 
or else DCON_CE.exe cannot be run automatically after booting. 

 
 
VCEP mode  
This mode is the same as Normal mode. Besides, VCEP.exe will be run automatically 
after booting. 
 

Tips & Warnings 

 VCEP.exe must be placed on the \System_Disk\Tools\VCEP or else 
VCEP.exe cannot be run automatically after booting. 
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User mode  
Rotary switch position 7, 8, 9 are reserved for user’s applications. 
When WinPAC is boot with one of these rotary switch positions, it is boot at normal 
mode. User’s application can check the rotary switch position to run at different mode. 
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2.4.  Using WinPAC Utility to manage the WinPAC 

The WinPAC Utility is a toolkit used to quickly control and configure the WinPAC. 
 
For more detailed information on WinPAC Utility applications, please refer to 
“3.5. WinPAC Utility” 
 

Step 1: Run the WinPAC Utility located on desktop 

 
 
 

 

Step 2: Configure IP address 
(DHCP), FTP Server, Auto 
Execution files, etc. 

 
 

 
 
 
 
 

Step 3: Save and Reboot the 
WinPAC 
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2.5.  Using DCON Utility to Configure I/O Modules 

DCON Utility is a tool kit used to quickly control and manage I-87K series expansion I/O 
modules. 
 

Step 1: Run the DCON firmware on the WinPAC 
 

The DCON firmware is located at: 
\System_Disk\tools\DCON_CE\ 
 
 
 

Step 2: Run the DCON Utility on 
the host PC 

 
The DCON Utility can be obtained 
from: 

CD:\Napdos\wp-8x4x_ce50\PC_Tools\DCON_Utility\ 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/pc_tools/dcon_utility/ 

    (For WP-8x3x and WP-8x4x series) 
 
 
 

Step 3: Click the WIN CE button 

 
 
 
 
 
 
 
 
 
 
 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/pc_tools/dcon_utility/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/pc_tools/dcon_utility/
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Step 4: Enter the IP address of the WinPAC to search the I-87K series 
expansion I/O modules 

 
 
 
 
 
 
 
 

 
 

Step 5: Select the module name that you want to configure 
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2.6.  Changing the User Interface Language 

The WinPAC is a Windows CE-based operating system which provides multilingual user 
interface and the user interface can be set to one of multi languages. 
 
 

Step 1: Open the Control Panel 

 
 
 
 
 
 
 
 
 
 
 
 

Step 2: Run the Regional Settings 

 

Step 3: Choose the display language, and then click OK 
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Step 4: Run the WinPAC Utility located on desktop 

 
 
 

 

 
 
 
 
 
 
 
 
 

Step 5: Save and Reboot 
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2.7.  Installing the Touch Panel Driver 

The WinPAC provides the Touch Panel driver for PenMount, Egalax, and ELO touch 
panels, and which can be obtained from WinPAC: 
\System_Disk\External_device_driver\ 
 
The table below provides a list of supported models and respective device driver 
names. 
 

Supported Model Driver Name 

ADP-1080T-U penmount_usb_touch_vyyyymmdd.cab 

ADP-1080T-R penmount_serial_touch_vyyyymmdd.cab 

GA-700YY-USB egalax_usb_touch_vyyyymmdd.cab 

GA-700YY-UOM egalax_serial_touch_vyyyymmdd.cab 

ELO USB touch panel elo_usb_touch_vyyyymmdd.cab 

ELO RS-232 touch panel elo_serial_touch_vyyyymmdd.cab 

 
For more information on how to make setting of touch panel driver, please refer to: 
http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_im
ages.htm 
 

 
 

http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm
http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm
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2.8.  Using Backup Utility to back up the settings and files 

After saving the configuration settings for a WinPAC device following the first use, it is 
recommended to use the Backup utility to back up all the data (settings and files). 
 
 

Step 1: Run the Backup Utility on the WinPAC 
 

The DCON firmware is located at: 
\System_Disk\tools\Backup_utility\ 
 
 
 
 
 
 
 
 
 

 
Step 2: Click the Backup menu 

 
 

 

 

 

 

 

Step 3: Select the options that 
you want to backup, 
enter text annotations 
and then click the Start 
backup button 
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Step 4: Confirm the backup 
options and then click 
Yes button 

 
 
 
 
 
 

Step 5: Choose the folder that you 
want to save backup file and 
click the Ok button 

 
 
 
 
 
 
 
 

Step 6: Wait for process to 
finish 
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2.9.  A caution about using System_Disk 

The System_disk is an authoritative storage device, but is not suitable for frequent 
copying and deleting of files and is only suitable for storing important files that are not 
changed frequently. 
If files are copied and deleted frequently, the system will automatically perform a 
System_Disk defragment action, which will consume the total resources of the CPU and 
cause the OS not to function correctly. 
When the OS System_Disk defragment action is being performed, the run LED will blink 
and the defragment action icon will show in the system tray in the bottom right-hand of 
the pc screen. 
 
 

Tips & Warnings 

 Don not power off or restart the 
WinPAC while the defragment 

is being performed. 
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3.  Tools and Tasks 

This chapter briefly describes the functions of the WinPAC software toolkits. 
 
Following tools has been installed on the WinPAC. 
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 Backup_Utility 

 
The Backup_Utility is a system backup/restore tool used to backup/restore all the data 
(OS, settings and files) from/to the WinPAC/ViewPAC device.  
For more information about the Backup Utility, please refer to “3.6.Bacup Utility”. 
 

 
Dcomcnfg 

 
dcomcnfg.exe for Windows CE to configure your DCOM settings. 
NTLMUser.exe for Windows CE to create local NTLM accounts on the Windows CE 
Device. 
 

 
 DCON_CE 

 
With Host PC running the DCON Utility, on the WinPAC, the DCON_CE program 
allows user to view and monitor the status of the DCON Utility. 
 
 

 ISQLW35 
 

The ISQLW35 implements SQL server compact 3.5 Query Analyzer. 
 
 
 Modbus 

 
The Modbus provides various applications of Modbus protocol for configuring the 
WinPAC. 
 
 

 NAPOPC_CE5 
 

NAPOPC_CE5 is an integrated omnibus software package, it allows user to quickly 
establish a DCS control system.  
For more information about the NAPOPC_CE5, please refer to “3.2. NAPOPC_CE5”. 
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 RegistryEditor 
 

The RegistryEditor allows user to editor the registry value of Windows CE Operating 
System. 
 
 

 RegistryViewer 
 

The Registry Viewer allows user to view the registry value of Windows CE Operating 
System. 
 
 

 Remote display application  
 

The remote display application allows user to view the display remotely of the WinPAC 
on a Host PC. 
 
 

 SendToCOM 
 

The SendToCOM allows user to send/receive data to/from the expansion module via 
serial port. 

 
 
 TaskMgr 

 
The TaskMgr provides details about programs and processes running on the WinPAC. 
 
 

 VCEP 
 

The VCEP allows user to manage the WinPAC remotely on a Host PC.  
For more information about the VCEP, please refer to “3.4. VCEP (Virtual CE Pro)”. 
 
 

 WinPAC Utility 
 

The WinPAC Utility provides various useful functions such as configuring Ethernet 
settings, monitoring system settings and FTP services .etc for easy and quick 
management.  
For more information about the WinPAC Utility, please refer to “3.5. WinPAC Utility”.
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3.1.  DCON Utility 

 
The DCON Utility is a toolkit that help user search the network, easily to Configure the 
I/O modules and test the I/O status via the serial port (RS-232/485) or Ethernet port 
(using virtual com port). It supports not only the DCON Protocol I/O modules but also 
the M Series I/O Modules (Modbus RTU M-7K, M-87K and will support Modbus ASCII 
M-87K) now. 
 
 
For more detailed information on WinPAC Utility applications, please refer to 
“2.5. Using DCON Utility to configure the I/O modules” 
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3.2.  NAPOPC_CE5 

NAPOPC_CE5 DA Server is a free OPC DA Server (The "OPC" 
stands for "OLE for Process Control" and the "DA" stands for " Data 
Access") working on WinPAC, ViewPAC & WinCon controllers 
provided by ICP DAS Ltd. The first standard (originally called simply 
the OPC Specification and now called the Data Access Specification) 

resulted from the collaboration of a number of leading worldwide automation suppliers 
working in cooperation with Microsoft. Originally based on Microsoft's OLE COM 
(component object model) and DCOM (distributed component object model) 
technologies, the specification defined a standard set of objects, interfaces and 
methods for use in process control and manufacturing automation applications to 
facilitate interoperability. NAPOPC_CE5 DA Server integrates OPC, Modbus TCP Slave 
and Modbus RTU Slave three kind Slave services, as well as integrates Modbus TCP 
Master, Modbus RTU Master and DCON three kind Master communication protocols. It 
also provides one advanced function “Rule Script” for use in the I/O integration and 
transformation, and some conditional Logic operation. 
 
Any version before 2.1.0 of the NAPOPC_CE5 was named “Quicker” 
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3.3.  SendToCOM 

The SendToCOM uses the serial port to communicate with expansion module. To use 
the SendToCOM, you can send data to expansion module through the serial port, and 
receive data from other device through the serial port. 
 
For more information about these commands for communicating with expansion module, 
please refer to: 
CD:\Napdos\io_module\87k_high_profile_modules.htm 
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3.4.  VCEP 

ICPDAS VCEP is designed 
for managing your WinPAC 
anywhere. No matter where 
you are, ICPDAS VCEP 
provides a convenient 
environment on the 
Desktop PC and allows you 
control your WinPAC 
remotely. 

 
ICPDAS VCEP is composed of two main components: 
The “Server” which runs on WinPAC. 
The “Client" which runs on a Desktop PC. 
 
Once a connection is established between the client and server (initiated by the client), 
the client will periodically send requests for screen updates and send mouse/key click 
information to the server to simulate. Each video frame is inter-compressed against the 
previous frame and then intra-compressed with a modified LZW scheme to minimize the 
amount of data transmitted from server to client. 
 
For more detailed information on VCEP application, please refer to 
http://www.icpdas.com/products/PAC/wincon-8000/wincon_VirtualCE.htm 
 

http://www.icpdas.com/products/PAC/wincon-8000/wincon_VirtualCE.htm
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3.5.  WinPAC Utility 

The WinPAC Utility is a tool which is designed to quickly control and manage the 
WinPAC. 
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3.5.1.  Menu Bar 

 
The WinPAC Utility includes the following function menu. All function menu will be 
explained later. 

 

 

 File Menu 
 

 
 
 Help Menu 
 

 
 
 Configuration Menu 
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File Menu 
 
 

 
 
The menu commands Use to 
Save Saves the settings into Flash. 

The new settings don’t take effect until the WinPAC 
restart. 

Save and Reboot Saves the settings into Flash and restart the 
WinPAC. 
The new settings will take effect after the WinPAC 
restart. 

Reboot Without Save Restarts the WinPAC without save the settings into 
Flash. 

Restore Default Settings Restarts the settings of WinPAC to its factory default 
values. 
The settings include configuration setting, network 
setting, auto execution, etc. 

Exit Exits the WinPAC Utility. 
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Help Menu 
 
 

 
 

The menu commands Use to 
Reset System to Default Resets the system interrupt status to default. 

The operation used in the situation when the 
interrupt crash. 
You can select this operation to reset the interrupt 
status without rebooting the device. 

Release Notes Checks out what’s new and the know issues. 
About Displays a dialog box with information about 

WinPAC Utility, including the current version and 
copyright information. 
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Configuration Menu 
 
 

 
 

The menu commands Use to 
Import Registry Key Backs up a sub-key of registry by using a registration 

entry (.reg) file.  
How to use: 
Step 1: Select the “Import Registry Key”, then the 
“Open” dialog box will appear 
Step 2: On the “Open” dialog box, select a 
specific .reg file to import  
Warning: 
1. The .reg file should be saved by “Export Registry 
Key”. 
2. It will not save automatically after import a .reg file. 

Export Registry Key Makes a backup of a registry sub-key  
How to use: 
Step 1: Select the “Export Registry Key”, then the 
“Export Registry” box will appear 
Step 2: Select a specific root key 
Step 3: Input a specific path of sub-key 
Step 4: Push the “OK” button, then the “Save As” 
dialog box will appear prompting you to select a 
location where you want to save this exported file  
Warning: 
The export operation will export all the sub-keys of 
the specific key which you input. 

Store All Registry 
Setting 

Stores all registry setting to flash from .das file which 
is saved by “Dump All Registry Setting”.  
How to use: 
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The menu commands Use to 
Step 1: Select the “Store All Registry Setting” , then 
the “Open” dialog box will appear 
Step 2: On the “Open” dialog box, select a 
specific .das file to store  
Warning: 
1. The .das file should be saved by “Dump All 
Registry Setting”. 
2. It will save automatically after store .das file. 

Dump All Registry 
Settings 

Dump all registries setting to .das file.  
How to use: 
Select the “Dump All Registry Setting”, then the 
“Save As” dialog box will appear prompting you to 
select a location where you want to save this 
exported file. 
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3.5.2.  Property Tabs 

The WinPAC Utility includes the following property tabs, all property tabs will be 
explained later. 

 

 

 

 

 

 

 

 

 

 

 

 

 System Setting 

 System Settings2 

 Ethernet Setting 

 Network Setting 

 System Information 

 Auto Execution 

 Multi-serial port wizard 

 System Memory Setting 

 Backplane Compatibility
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System Setting Tab 
 
 
The System Setting tab provides functions to configure the task bar HTTP directory 
path. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The tab use to How to use 
Adjust the size of the desktop Select a display resolution from the 

Resolution list. 
Lock or Auto-Hide the taskbar Auto-Hide: 

Select the Auto Hide check box 
Lock: 
Select the Always On Top check box. 

Check the status of the battery See the Battery1 and Battery2 field that 
displays the battery status. 

 
Note: Use the battery type BR1632 (part number is 2LB010 for ICP DAS) if you need to 
replace it. 
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Ethernet Setting Tab 

 
 
The Ethernet Setting tab provides functions to configure either DHCP (Roaming) or 
manually configured (Static) network settings and to monitor the MAC address. 
Generally, DHCP is the default settings, but if you don’t have a DHCP server, you must 
configure the network settings by using manual configuration. 

 
 

The tab use to How to use 
Configure the network 
settings 

Obtaining an IP address automatically from 
DHCP: 
Select the Use DHCP to get IP address option. 
Manually assign an IP address: 
Select the Assign IP address option. 

Monitor the MAC address See the MAC Address 1 and MAC Address 2 
fields that display the physical address of LAN1 
and LAN2. 
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Network Setting Tab 

 
 
The Network Setting tab includes two tabs, FTP Setting and Users and Password.  
The FTP settings tab provides functions to enable/disable the FTP access, 
enable/disable anonymous FTP access, and configure the FTP directory path. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The tab use to How to use 
Enable or disable 
the FTP access 

Enable: 
Select the Enable check box in the FTP field. 
Disable: 
Select the Disable check box in the FTP field. 

Enable or disable 
anonymous FTP 
access 

Enable: 
Select the Enable check box in the Allow Anonymous field. 
Disable: 
Select the Disable check box in the Allow Anonymous field. 

Enable or disable 
anonymous FTP 
upload 

Enable: 
Select the Enable check box in the Allow Anonymous 
Upload field. 
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The tab use to How to use 
Disable: 
Select the Disable check box in the Allow Anonymous 
Upload field. 

Change the FTP 
directory path 

Enter a new path in the Change FTP default download 
directory field, and then press the Setting button. 
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The FTP settings tab provides functions to add, delete, and manage the user account 
for FTP, telnet and Web server access.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The tab use to How to use 

Add a user 
account 

Fill in the User name and Password field of your user account, 
press the Add button, and then press the Setting button 

Delete a user 
account 

Choose a user name from the user account list, the user 
account that you select will display in the User name and 
Password filed, press the Delete button, and then press the 
Setting button 

* The maximum number of the user accounts is 5. 

* The maximum of the string length of the user name and password fields must 
be less than 20 charachters. 

 
For more information on how to use a user account to login WinPAC, please refer to 
“E.1. How to set up a telnet and FTP account to login WinPAC” 
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System Information Tab 

 
 
The System Information tab provides functions to monitor necessary system information 
of the WinPAC. The system information is the most important note of version control for 
upgrading system. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Auto Execution Tab 
 
 
The Auto Execute tab provides functions to configure programs running at WinPAC 
startup, it allows users to configure ten execute files at most. 

 

The allowed file types are .exe and .bat, and they are executed in 
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order of program 1, program 2, etc. 

 

 
 

The tab use to How to use 
Configure programs 
running at startup 

Press the Browse button to select the execute file 
which you want, and then press the Setting button. 

 
 
 

Multi-Serial Port Wizard Tab 
 

 
The Multi-serial port provides functions for 
installation of the RS-232/RS-422/RS-485 
communication module driver. 
 
The table below shows the expansion 
RS-232/RS-422/RS-485 communication modules 
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that are compatible with the WinPAC. 
 
 
Item RS-232 RS-422/RS-485 Isolation Connector 
I-8112iW 2 - 2500 Vrms DB-9 x 2 

I-8114W 4 - - DB-37 x 1 

I-8114iW 4 - 2500 Vrms DB-37 x 1 

I-8142iW - 2 2500 Vrms Terminator block x 1 

I-8144iW - 4 2500 Vrms Terminator block x 1 
 
The WinPAC can be expanded to support up to 16 COM ports.  
For more detailed information about these support modules, please refer to 
http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm
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System Memory Setting Tab 

 
 
The System Memory Setting tab provides functions to adjust and monitor the unused 
RAM.  

 
 
The tab use to How to use 
Adjust display Move the slider left to release more memory running 

programs or move the slider right to release more 
storage room, and then press the Setting button 
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Backplane Compatibility Tab 

 
 
The Backplane Compatibility tab provides functions to keep old programs running on 
WinPAC without any modification. 

 
 
The tab use to How to use 
Configure programs 
running at WinCON-8000 

Select the “COM Port Backward Compatible for 
WinCon” and then press Setting button 
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4.  Your First WinPAC Program 

This chapter describes the components of the WinPAC SDK, and provides step by step 
tutorial for developer that will teach you how to create your first WinPAC program. 
 
Before writing your first program, ensure that you have the necessary development tools 
and the corresponding WinPAC SDKs are installed on your system. 
 
 
 
4.1.  Preparing the Development Tools 

There are several programming tools available for application developers targeting 
Windows CE-based WinPAC. One of the following tools must be installed on the Host 
PC.  
 Microsoft eMbedded Visual C++ 
 Visual Basic.net  
 Visual C# 

 
Notes: 

1. There is no support for development of both managed and unmanaged code 
on WinPAC series platform in VS2010/VS2012. 

2. WinCE-based platform development is only supported in Visual studio 
Professional edition or better, no Express or Standard edition. 
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4.2.  Installing WinPAC Platform SDKs 

The WinPAC Platform SDK is a Software Development Kit (SDK) that contains C header 
files, C libraries and documents. 

Below is a step by step procedure for installing the WinPAC Platform SDKs. 
 

Step 1: Insert the CD into your CD-ROM drive 
 

Step 2: Execute the “PAC270_SDK_YYYYMMDD.msi” which is located in 

CD:\Napdos\wp-8x4x_ce50\SDK\PlatformSDK  
for WP-8x3x and WP-8x4x series 

 

 
The installation program for the latest version of the WinPAC Platform SDKs can be 
obtained from: 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/platformsdk/ 
File name: pac270_sdk_yyyymmdd.msi 
yyyymmdd: platform sdk released date 

 

Tips & Warnings 

The released date of the installation program SDK installation 
package that provides the PACSDK library must be later than or 

equal to 2012/10/15, such as PAC270_SDK_20121015.msi 

 
 

Step 3: Follow the prompts until the installation is complete 
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4.3.  Understanding the WinPAC SDK 

The WinPAC SDK includes several application programming interfaces (APIs) that 
allows you perform various supporting tasks when developing WinPAC. 
 
 
 Requirements 

The WinPAC SDK only supports .NET Compact Framework 2.0 or above. 
 
 Installation Path 

After installing the WinPAC SDKs, a number of functions can be installed on the Host 
PC, and this installation puts the header files, libraries into the following public places so 
they are easily changed by update the WinPAC SDKs. 
 
Header files: 
C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 

 
Libraries: 
C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 
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4.3.1.  WinPAC SDK Overview 

 
 
 
 
 

System Operation 

¬ System Information 

¬ Backplane Access 

¬ Interrupt 
¬ Memory Access 

PAC_IO 

Remote I/O Local I/O 

¬ Watchdog 

¬ UART 

¬ Registry 
¬ Micro SD 
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 System Information Functions 
Provides reference information for the system status. 
 
 Backplane Access API 
Provides reference information for the backplane access APIs, including backplane 
information. 
 
 Interrupt API 
Provides reference information for the Interrupt APIs  
 
 Memory Access API 
Provides reference information for the memory R/W APIs, including EEPROM and 
SRAM.  
 
 Watchdog Functions 
Provides reference information for the watchdog APIs, including hardware watchdog 
and OS watchdog. 
 
 Uart API 
Provides reference information for the Uart APIs. 
 
 Registry API 
Provides reference information for the registry.  
 
 MicroSD Management API 
Provides reference information for the MicroSD Manager. 
 
 PAC_IO API 
Provides reference information for IO APIs, including local and remote. 
In additions, no matter 8K or 87K modules use the same API. 
 
 Error Handling API 
Provides reference information for error handling. 
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4.3.2.  WinPAC SDK Reference 

For full usage information regarding the description, prototype and the arguments of the 
functions, please refer to the “PAC Standard API Manual” for both WP-8x3x and 
WP-8x4x series located at: 
 

CD:\Napdos\wp-8x4x_ce50\Document\SDK_Document\ 
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/document/sdk_document/ 
 
 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/document/sdk_document/
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4.4.  Your First Program in C# 

Here we will explain how to create a C# program running on WinPAC. We assume that 
you use Visual Studio 2005/2008. 

Depending on the version of  
 
To create a demo program with C# development tool includes the following main steps:  

1. Create a new project 
2. Add project reference for an application 
3. Design and Build an application program 
4. Execute the application on the WinPAC  

All main steps will be described in the following subsection. 
 
 

4.4.1.  Create a new project 

Step 1: Start the Visual Studio 2005 

Step 2: On the “File” menu, select the “New” command, and then click the 
“Project” command 
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Step 3: In the “New Project” dialog box do the following in this order 
 

 
 

Step 4: Click OK to start creating a “systeminfo” project 
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4.4.2.  Add project reference for an application 

Step 1: On the “Solution Explorer” window, right-click the “Reference” and 
then click the “Add Reference…” command 

 

 

Step 2: In the “Add 
Reference” dialog box, 
select the “Browse” tab, and 
then specify the directory of 
the “PACNET.dll” file in the 
“File name” field 

 

 

 

The “PACNET.dll” file for WP-8x3x and WP-8x4x can be obtained from: 

 
CD:\Napdos\wp-8x4x_ce50\SDK\WinPacNet\ 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/
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4.4.3.  Design and Build an application program 

 

Step 1: Add a “button” object in the “From1” dialog box 

 

Step 2: Right-click the “button” object and click the “Properties” command 
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Step 3: On the “Properties” window, type “Check the OS version” in the 
“Text” edit box 

 

 

Step 4: In the “Form1” dialog box, double-click the button” object to open 
the editor window 

 

 

 

 

 

 

 

 

Double-click 
the button 
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Step 5: Insert the “using PACNET;” into the header area after “using 
System.Windows.Forms;” 

 
 
 
 
 
 
 
 
 
 
 
 
 

Tips & Warnings 

The “PACNET” of “using PACNET” is case- sensitive 
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Step 6: Insert the following code in the Editor Window 

 

MessageBox.Show(PACNET.Sys.GetOSVersion()); 

MessageBox.Show(Sys.GetOSVersion()); 
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4.4.4.  Execute the application on the WinPAC 

 

Step 1: On the “Build” menu, click the “Build Solution” command 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 
server of WinPAC 

 

Step 3: Upload the “systeminfo.exe” application and the corresponding 
“PACNET.dll” file to the WinPAC via the WinPAC FTP server 
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Tips & Warnings 

For applications programming in C# and VB.net with .net compact 
framework, when executing these application on the WinPAC 
controller, the corresponding “PACNET.dll” file must be in the 
same directory as the .exe file. 

 
 

Step 4: On the WinPAC, execute the uploaded file 
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4.5.  Your First Program in VB.net 

To create a demo program with C# development tool includes the following main steps:  
1. Create a new project 
2. Add project reference for an application 
3. Design and Build an application program 
4. Execute the application on the WinPAC  

All main steps will be described in the following subsection. 
 
 

4.5.1.  Create a new project 

 

Step 1: Start the Visual Studio 2005 

 

Step 2: On the “File” menu, select the “New” command, and then click the 
“Project” command 
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Step 3: In the “New Project” dialog box do the following in this order 

 

 
 

Step 4: Click OK to start creating a “systeminfo” project 
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4.5.2.  Add project reference for an application 

Step 1: On the “Class View” window, right-click the “Reference” and then 
click the “Add Reference…” command 

 

 

 

Step 2: In the “Add Reference” dialog 
box, select the “Browse” tab, and then 
specify the directory of the 
“PACNET.dll” file in the “File name” 
field 

 

 

 

 

The “PACNET.dll” file for WP-8x3x and WP-8x4x can be obtained from: 

CD:\Napdos\wp-8x4x_ce50\SDK\WinPacNet\ 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/  
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4.5.3.  Design and Build an application program 

 

Step 1: Add a “button” object in the “From1” dialog box 

 

Step 2: Right-click the “button” object and click the “Properties” command 
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Step 3: On the “Properties” window, type “Check the OS version” in the 
“Text” edit box 

 

 

Step 4: In the “Form1” dialog box, double-click the button” object to open 
the editor window 

 

 

 

 

 

 

 

 

Double-click 
the button 
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Step 5: Insert the following code in the Editor Window 

 

1. Imports PACNET 

2. MessageBox.Show(PACNET.Sys.GetOSVersion()) 

3. MessageBox.Show(Sys.GetOSVersion()) 

 

 
 
 
 
 
 
 
 
 
 
 

Tips & Warnings 

The “PACNET” of “Imports PACNET” is case- sensitive 
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4.5.4.  Execute the application on the WinPAC 

 

Step 1: On the “Build” menu, click the “Build Solution” command- 

 

 

Step 2: Open the web browser and type the IP address to connect the FTP 
server of WinPAC 

 

Step 3: Upload the “systeminfo.exe” application and the corresponding 
“PACNET.dll” file to the WinPAC via the WinPAC FTP server 
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Tips & Warnings 

For applications programming in C# and VB.net with .net 
framework, when executing these application on the WinPAC 
controller, the corresponding “PACNET.dll” file must be in the 
same directory as the .exe file 

 

 
 

Step 4: On the WinPAC, execute the uploaded file 
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4.6.  Your First Program in eMbedded Visual C++ 

To create a demo program with eMbedded Visual C++ development tool includes the 
following main steps:  
1. Create a new Forms-Based project 
2. Configure compiler options 
3. Design and Build an application program 
4. Execute the application on the WinPAC  

All main steps will be described in the following subsection. 
 
 

4.6.1.  Create a new Forms-Based project 

Step 1: Start the Microsoft Embedded Visual C++ 

 

Step 2: From the “File” menu, click the “New” command 
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Step 3: In the “New” dialog, select the “Projects” tab and do the following in 
this order 

 

 

Tips & Warnings 

The selected CPU type must have “Win32 [WCE ARMV4I]” 

 
 

Step 4: Click the “OK” button to start the wizard 
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Step 5: On the first page of the wizard, select “Dialog based” option and 
then click the “Next” button to the next step 

 

 

Step 6: On the next page of the wizard, leave all the options as they are, and 
then click the “Next” button to the next step 
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Step 7: On the next page of the wizard, leave all the options as they are, and 
then click the “Next” button to the next step 

 

 

 

Step 8: On the next page of the wizard, leave all the options as they are, and 
then click the “Finish” button to complete the wizard 
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Step 9: The final summary appears, click the “OK” button to exit the wizard 
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4.6.2.  Configure compiler options 

 

On the WCE configuration toolbar, select the “Win32 [WCE ARMV4] 
Release” 
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4.6.3.  Specify the path for project reference 

 

Step 1: Click the “Options…” command from the “Tools” menu 
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Step 2: In the “Option” dialog, select the “Directories” tab and do the 
following in this order to specify the header file include path 

The specified include path of the header file is default located at: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click this button 
to specify the 

header file 
include path 
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Step 3: In the “Option” dialog, select the “Directories” tab and do the 
following in this order to specify the library file path 

The specified include path of the library file is default located at: 

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click this button 
to specify the 

library file path 
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Step 4: Click the “Settings…” command from the “Project” menu 

 

 

Step 5: In the “Project Settings” dialog box do the following in this order 
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4.6.4.  Design and Build an application program 

Step 1: On the “Workspace” window, select the “ResourceView” tab and 
expand the “dialog” folder, and then double-click the 
“IDD_DEMO_DIALOG” to open the dialog box 

 

 

Step 2: Add the “button” object in the “systeminfo” dialog box 
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Step 3: In the “systeminfo” dialog box, right-click the button object and then 
click the “Properties” command 

 

 

Step 4: Type the “Check the OS version” in the “Caption” edit box and then 
click the “close” button 
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Step 5: In the “systeminfo” dialog box, double-Click the button object 

 
 

Step 6: Type the “OnBtnCheckOS” in the “Member function name” edit box 
and then click the “OK” button 

 

 

 

 

 

 

 

 

 

Double-click 
the button 
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Step 7: Insert the following code into the Editor Window 
 

char OS[32]; 
TCHAR buf[32]; 
pac_GetOSVersion(OS); 
pac_AnsiToWideString(OS, buf); 
MessageBox(buf,0,MB_OK); 

 

 

 

Step 8: Insert the “#include “PACSDK.h”” into the header area 
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4.6.5.  Execute the application program on WinPAC 

Step 1: On the “Build” menu, click the “Build systeminfo.exe” command 

 

Step 2: Open the web browser and type the IP address to connect the FTP 
server of WinPAC 

 

Step 3: Upload the “systeminfo.exe” application to the WinPAC via the 
WinPAC FTP server 

 

Step 4: On the WinPAC, execute the 
uploaded file 

 

 



 

WinPAC 8000 User Manual, version 2.0.9   Last Revised: January 2014   Page: 125 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved.  ∗ E-mail: service@icpdas.com 
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5.  APIs and Demo References 

This chapter introduces demo programs that have been designed for the WinPAC. You 
can examine the demo source code, which includes numerous comments, to familiarize 
yourself with the WinPAC API. This will allow developing your own applications quickly by 
modifying these demo programs. The following details the contents of the WinPAC demo 
programs. 
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5.1.  Demo programs with C# 

 

The following C# demos have been designed to demonstrate the various features 
of the WinPAC. 
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5.1.1.  C# Demo programs for WinPAC Standard API 

The table below describes the WinPAC demos that have been designed to 
demonstrate the standard operation features of the WinPAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

WinPAC Standard API: 
 

Folder Demo Explanation 

system systeminfo 
Retrieves information about the OS 
version, CPU version, SDK version, 
etc. 

backplane backplaneinfo 
Retrieves information about the DIP 
switch, backplane ID and slot count. 

memoryaccess memory Shows how to read/write date values 

System Operation 

¬ System Information 

¬ Backplane Access 
¬ Interrupt 

¬ Memory Access 

¬ Watchdog 

¬ UART 
¬ Registry 

¬ Micro SD 
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Folder Demo Explanation 
from/to EEPROM 

battery_backup_sram 
Shows how to read or write to the 
battery backup 

watchdog watchdog Displays how the watchdog operate 

microsd microsd_management 
Shows how to enables/disables 
Micro SD 

registry registry 
Shows how to read/write date values 
from/to registry 

Uart diag 
Shows how to read the name of 
local I/O modules via UART 

 

The C# demo programs of WinPAC standard API for WP-8x3x and XP-8x4x can 
be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\WinPAC\ C#\Standard \ 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/c%23/s
tandard/ 
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5.1.2.  C# Demo programs for PAC IO API 

The table below describes the WinPAC demos that have been designed to 
demonstrate the expansion I/O module features of the WinPAC. 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

PAC_IO 

Remote I/O Local I/O 
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PAC IO API: 
 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and types 
which plugged in the WinPAC. 

8k_di 
Shows how to read the DI values of DI module. 
This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 
This demo program is used by 8K series DO modules. 

8k_dio 

Shows how to read the DI and the DO values of the 
DIO module.  
This demo program is used by 8K series DIO 
modules. 

87k_basic 
Shows how to send/receive a command/response 
application. 
This demo program is used by 87K series modules. 

87K_demo 
Shows how use uart API and the IO modules located 
as slots.  
This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 
This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 
This demo program is used by 87K series AO 
modules. 

87k_di 
Shows how to read the DI values of DI module. 
This demo program is used by 87K series DI modules. 

87k_do 
Shows how to write the DO values to DO module. 
This demo program is used by 87K series DO 
modules. 

87k_dio 

Shows how to read the DI and the DO values of the  
DIO module. 
This demo program is used by 87K series DIO 
modules. 

Remote 
7k87k_basic 

Shows how to send/receive a command/response 
application. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_ai Shows how to read the AI values of AI module. 



 

WinPAC 8000 User Manual, version 2.0.9   Last Revised: January 2014   Page: 132 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved.  ∗ E-mail: service@icpdas.com 

 

 

Folder Demo Explanation 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_ao 
Shows how to write the AO values to AO module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_di 
Shows how to read the DI values of DI module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_do 
Shows how to write the DO values to DO module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the 
DIO module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

 

The C# demo programs of PAC IO API for WP-8x3x and XP-8x4x can be obtained 
from: 

 

CD:\Napdos\wp-8x4x_ce50\Demo\ WinPAC\C#\IO 
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/c%23/io/ 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/c%23/io/
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5.2.  Demo Programs with eMbedded Visual C++ 

 

The following eVC demos have been designed to demonstrate the various 
features of the WinPAC. 
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5.2.1.  eVC Demo programs for WinPAC Standard API 

The table below describes the WinPAC demos that have been designed to 
demonstrate the standard operation features of the WinPAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

WinPAC Standard API: 
 

Folder Demo Explanation 

system Systeminfo 
Retrieves information about the OS 
version, CPU version, SDK version, 
etc. 

backplane Backplaneinfo 
Retrieves information about the DIP 
switch, backplane ID and slot count. 

memoryaccess Memory 
Shows how to read/write date values 
from/to EEPROM 

System Operation 

¬ System Information 

¬ Backplane Access 
¬ Interrupt 

¬ Memory Access 

¬ Watchdog 

¬ UART 
¬ Registry 

¬ Micro SD 
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Folder Demo Explanation 

battery_backup_sram 
Shows how to read or write to the 
battery backup 

watchdog watchdog Displays how the watchdog operate 

microsd microsd_management 
Shows how to enables/disables 
Micro SD 

registry registry 
Shows how to read/write date values 
from/to registry 

Uart diag 
Shows how to read the name of 
local I/O modules via UART 

 

The eVC demo programs of WinPAC standard API for WP-8x3x and XP-8x4x can 
be obtained from: 

CD:\Napdos\wp-8x4x_ce50\Demo\ WinPAC\eVC\Standard 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/st
andard/  

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/standard/
ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/standard/
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5.2.2.  eVC Demo programs for PAC IO API 

The table below describes the WinPAC demos that have been designed to 
demonstrate the expansion I/O module features of the WinPAC. 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

PAC_IO 

Remote I/O Local I/O 
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PAC IO API: 
 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and types 
which plugged in the WinPAC. 

8k_di 
Shows how to read the DI values of DI module. 
This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 
This demo program is used by 8K series DO modules. 

8k_dio 

Shows how to read the DI and the DO values of the 
DIO module.  
This demo program is used by 8K series DIO 
modules. 

87k_basic 
Shows how to send/receive a command/response 
application. 
This demo program is used by 87K series modules. 

87K_demo 
Shows how use uart API and the IO modules located 
as slots.  
This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 
This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 
This demo program is used by 87K series AO 
modules. 

87k_di 
Shows how to read the DI values of DI module. 
This demo program is used by 87K series DI modules. 

87k_do 
Shows how to write the DO values to DO module. 
This demo program is used by 87K series DO 
modules. 

87k_dio 

Shows how to read the DI and the DO values of the  
DIO module. 
This demo program is used by 87K series DIO 
modules. 

Remote 
7k87k_basic 

Shows how to send/receive a command/response 
application. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_ai Shows how to read the AI values of AI module. 
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Folder Demo Explanation 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_ao 
Shows how to write the AO values to AO module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_di 
Shows how to read the DI values of DI module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_do 
Shows how to write the DO values to DO module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the 
DIO module. 
This demo program is used by 7K or 87K series  
AI modules which connected through a COM port. 

 

The eVC demo programs of PAC IO API for WP-8x3x and XP-8x4x can be 
obtained from: 

 
CD:\Napdos\wp-8x3x_ce50\Demo\ WinPAC\eVC\IO 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/io/  

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/evc/io/
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6.  I/O Modules and SDK Selection 

This chapter describes how to select a suitable I/O expansion module and the 
corresponding SDK library for developing programs on WinPAC series devices. 
 
Selecting an SDK Library for I/O Expansion 

1. Local I/O (I-8K Series & I-87K Series) 
There are two types of I/O modules that can be inserted into local bus of a WinPAC 
device, Parallel and Serial. Parallel modules (I-8K Series) are high-speed modules 
and only support an MCU (Main Control Unit). Serial modules (I-87K Series) can 
support either an MCU or an I/O expansion unit. The following table shows the 
appropriate SDK library to be used for I/O modules. 

 

SDK 
Modules 

I-87K series I-87K series with 
PWM functions 

I-8K series Specified I-8K 
series 

Native SDK PACSDK.dll PACSDK_PWM.dll PACSDK.dll Specified SDK 
.NET CF 
SDK 

PACNET.dll PACNET.dll PACNET.dll Specified SDK 

 
 
 

 

1 

2 

4 

5 
3
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The details of the SDK libraries for a specific I/O Module are listed in the table below: 
Module Native SDK .NET CF SDK 
I-8017HW pac_i8017HW.dll pac_i8017HWNet.dll 
I-8014W pac_i8014W.dll pac_i8014WNet.dll 
I-8024W pac_i8024W.dll pac8024WNet.dll 
I-8026W pac_i8026W.dll pac_i8026WNet.dll 
I-8048W pac_i8048W.dll pac_i8048WNet.dll 
I-8050W pac_i8050W.dll pac_i8050WNet.dll 
I-8084W pac_i8084W.dll pac_i8084WNet.dll 
I-8088W pac_i8088W.dll pac_i8088WNet.dll 
I-8093W pac_i8093W.dll pac8093WNet.dll 
I-87088W PACSDK_PWM.dll PACNET.dll 
Other I-8K & I-87K 
modules 

PACSDK.dll PACNET.dll 

   
2. RS485 (I-7K Series & M-7K series) 

I-7000, M-7000, RU-87Pn and high profile I-87K series modules connect to WinPAC 
series devices via a twisted-pair, multi-drop, 2-wire RS-485 network. 

    

SDK 
Modules 
I-7K series I-7K series with 

PWM functions 
M-7K series RU-87Pn + 

I-87K 
Native SDK PACSDK.dll PACSDK_PWM.dll Modbus Demo Refer to the 

I-8K Series & 
the I-87K 
Series 

.NET CF 
SDK 

PACNET.dll PACNET.dll Modbus Demo Refer to the 
I-8K Series & 
the I-87K 
Series 

 
The detail of the SDK library to be used for a specific I/O Module is listed in the table 
below: 
Module Native SDK .NET CF SDK 
M7000 series Modbus Demo Modbus Demo 
I-7088W PACSDK_PWM.dll PACNET.dll 
Other I-7K modules PACSDK.dll PACNET.dll 
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3. Ethernet 
The Ethernet I/O devices available include ET-6000, ET-7000, I-8KE4/8 and 
I-8KE4/8-MTCP, and support either the DCON or the Modbus/TCP protocol. 

Module Native SDK .NET CF SDK 
ET-6K/ET-7K series Modbus Demo Modbus Demo 

 
4. FRnet 

FRnet is an innovative industrial field bus technology that uses twisted pair cable as 
the transmission medium. The status of all I/O devices is updated on a fixed cycle, no 
matter how many FRnet I/O modules are connected to the FRnet network. 

Module Native SDK .NET CF SDK 
I-8172W pac_i8172W.dll pac8172WNet.dll 

 
5. CAN Bus 

The Controller Area Network (CAN) is a serial communication way, which efficiently 
supports distributed real-time control with a very high level of security. It provides the 
error-processing mechanisms and concepts of message priority. These features can 
improve the network reliability and transmission efficiency.  

Module Native SDK .NET CF SDK 
I-8120W I8120.dll I8120net_pac.dll 

 
Selection Guide for a I/O Module Demo Program 

I-7K series: 
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicable
d_demo_for_7k_module.pdf 

I-87K series: 
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicable
d_demo_for_87k_module.pdf 

I-87K series: 
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicable
d_demo_for_8k_module.pdf 

Modbus demo: 
 http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/nmodbus/ 

 CAN Bus demo: 
ftp://ftp.icpdas.com/pub/cd/fieldbus_cd/can/slotmodule/i_8120w/demos/ 

http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_87k_module.pdf
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_87k_module.pdf
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_8k_module.pdf
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/winpac/applicabled_demo_for_8k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/demo/nmodbus/
ftp://ftp.icpdas.com/pub/cd/fieldbus_cd/can/slotmodule/i_8120w/demos/
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7.  WinPAC Updates 

This chapter provides instructions on how to upgrade WinPAC OS and SDK. 
 
ICP DAS will continue to add additional features to WinPAC SDK and OS in the future, so 
we advise you to periodically check the ICP DAS web site for the latest updates. 
 
WinPAC updates services can be divided into the following two main categories: 
 
 

 
 

1. OS updates 

2. SDK updates 
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7.1.  OS updates 

The updates files of OS image are located on:  
 For WP-8x3x series 

CD:\Napdos\wp-8x3x_ce50\OS_Image\ 

 For WP-8x4x series 
CD:\Napdos\wp-8x4x_ce50\OS_Image\ 

 

 

There are two ways to update the OS: 

1. Update from file (Please refer to section 6.1.1) 

 (We recommend that you use this one for more quicker and easier to update) 

2. Update from Eshell (Please refer to section 6.1.2) 
 

 
 

Upgrad
e LAN1 

Upgrad
e 
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The WinPAC OS supports multi-language: 

1. en - English 

2. sc - Simplified Chinese 

3. tc - Traditional Chinese 
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7.1.1.  WinPAC OS updates using installation package file on WinPAC 

 

Installation package is easier to upgrade OS image, you just copy the package file 
(.exe) and the corresponding “AutoInit.bat” file to WinPAC, and then double-click 
installation package file to run it. 

 

 

 

 

 

 

Below is a step by step procedure for updating the WinPAC OS. 
 

Step 1: Get the latest version of the installation package file and the 
corresponding “AutoInit.bat” file downloading to WinPAC 

 
The latest version of the installation package file and the corresponding “AutoInit.bat” 
file can be obtained from:  

 For WP-8x3x series 
CD:\Napdos\wp-8x3x_ce50\OS_Image\update_from_file\ 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/update_from
_file/ 

 For WP-8x4x series 
CD:\Napdos\wp-8x4x_ce50\OS_Image\update_from_file\ 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from
_file/ 

 

Upgrade 

 
--------
--------
--------
--------

 

 
--------
--------
--------
--------

 

Installation package file  
& AutoInit.bat file 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_file/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_file/
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The corresponding “AutoInit.bat” file can be obtained from the same folder. 
 

  
There are several ways to download the installation package file and the 
corresponding file to WinPAC:  
i. On the WinPAC, you can download these files via Ethernet connection. 
ii. On the PC, you can download these files via .a USB storage device, the removable 

Micro SD card or FTP server 
 

Step 2: Run the installation package file and then click “OK” to make sure 
you receive the important notice of this procedure will ease flash 
memory 
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Step 3: Click “Update Now” to start the process 
 

 

Step 4: Click “Yes” to make sure you ready to start the process 
 

 
 
This installation procedure will perform the following tasks:  
i. Install boot loader file 

Important Warnings 

Be careful, if the boot loader broken off in this step and cannot 
restart in safe mode, you have to send it back to us. 

 
ii. Erase flash disk 
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iii. Install OS image 
iv. Set and save registry 

Tips & Warnings 

This procedure will reset the registry settings to their default settings, 
and all of your settings will be lost. 

During this time, do not turn off the WinPAC. If the update is 
cancelled before completion, the WinPAC may become damaged 
and may require servicing or exchange. 

Besides, we recommend that you turn off all other applications 
before starting to upgrade the OS.  

 
Step 5: After completing the above-mentioned tasks, the “Warning !” dialog 

box will appear as follow, before clicking the “OK” button, you must 
first turn the rotary switch to the “0” position 
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Step 6: Check the WinPAC OS version 
 

Start the WinPAC Utility, and then select the “System Information” tab to check the 
current OS version. 

 

 

 

 

Check the 
 OS version 
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7.1.2.  WinPAC OS updates using Eshell via Ethernet 

 

 

 

 

By default, the OS updates via LAN1. 
Therefore, to update the OS image, make 
sure LAN1 is connected to the PC. 

 

 

Below is a step by step procedure for updating the WinPAC OS. 
 

Step 1: Get the latest version of the WinPAC OS image 
 

The latest version of the installation package can be obtained from:  

 For WP-8x3x series 
CD:\Napdos\wp-8x3x_ce50\OS_Image\update_from_Eshell\ 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/update_from
_Eshell/ 

 For WP-8x4x series 
CD:\Napdos\wp-8x4x_ce50\OS_Image\update_from_Eshell\ 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from
_Eshell/ 

 

LAN1 

Upgrade 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/os_image/update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_Eshell/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/os_image/update_from_Eshell/
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Step 2: Run the ESHELL on the PC 

 

 

ESHELL you can be obtained at: 

 
 

 For WP-8x3x series 
CD:\Napdos\wp-8x3x_ce50\PC_Tools\ 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/pc_tools/ 

 For WP-8x4x series 

CD:\Napdos\wp-8x4x_ce50\PC_Tools\  
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/pc_tools/ 

 

Step 3: Configure the reboot in OS update mode 

 

 

 

Turn the rotary switch to “3”, and then reboot 
the WinPAC. 

 

 

 

Step 4: Select the device which you want to update the OS image 
 

After starting the ESHELL software, the “Select Device” dialog will appear, and 
then select the device which you want. 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x3x_ce50/pc_tools/
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/pc_tools/
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Step 5: Select the latest version of the OS image file 
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Step 6: Once the procedure is completed, the “Warning !” dialog box will 
Appear on WinPAC screen as below shown, click “No” to finish the 
process 

 

 

Step 7: Configure the WinPAC to boot in normal mode 

 

 

 
 

 

 
 
 

 

Step 8: Run the WinPAC Utility to save the settings and reboot the WinPAC 
 

Run the WinPAC Utility, and then select 
the “Save and Reboot” command from 
the “File” menu to save the settings and 
reboot the WinPAC 
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Step 9: Click “Yes” to reboot the WinPAC 
 

 

Step 10: Check the WinPAC OS version 
 

Start the WinPAC Utility, and then select the “System Information” tab to check the 
current OS version. 

 

 

Check the 
 OS version 
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7.2.  SDKs Updates 

The updates files of SDK are located on:  
 For WP-8x3x and WP-8x4x series 

CD:\Napdos\wp-8x4x_ce50\SDK\ 
 

 
By eVC and donet development tools, the WinPAC SDK installation is divided into the 
following two parts:  

i. WinPAC SDK updates for dotnet 
ii. WinPAC SDK updates for eMbedded Visual C++ 
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7.2.1.  WinPAC SDK updates for C# or VB.net 

To determine the SDK version that is compatibly running on the WinPAC, you can 
read the “Release Note” which is located under each SDK folder, these files 
provides important updated information for what we fixed and added. 

 

 

Step 1: Get the latest version of the C# or VB.net components 
 

The latest version of the C# or VB.net components can be obtained from:  

 For WP-8x3x and WP-8x4x series 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/ 

 

 

Step 2: Copy the latest version of DLL to Host PC and WinPAC 
 

The DLL files on Host PC are located at anywhere only the solution can reference 
it. 

The DLL files on WinPAC are located at the same directory as the .exe file. 

 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacnet/
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7.2.2.  WinPAC SDK updates for eMbedded Visual C++ 

To determine the SDK version that is compatibly running on the WinPAC, you can 
read the “Release Note” which is located under each SDK folder, these files 
provides important updated information for what we fixed and added. 

 

 

Step 1: Get the latest version of the eMbedded Visual C++ components 
 

The latest version of the eMbedded Visual C++ components can be obtained 
from:  

 For WP-8x3x and WP-8x4x series 
http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacsdk/ 

 

 

Step 2: Copy the latest version of header files and libraries to Host PC 
 

The header files are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Include\ARMV4I\ 

The libraries are located at:  

C:\Program Files\Windows CE Tools\wce500\PAC270\Icpdas\Lib\ARMV4I\ 

 

Step 3: Copy the latest version of DLL files to WinPAC 
 

The DLL files are located at:  

\System_Disk\ICPDAS\System 

 

http://ftp.icpdas.com/pub/cd/winpac/napdos/wp-8x4x_ce50/sdk/winpacsdk/
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8.  WinPAC Download Center 

This chapter introduces the WinPAC Download Center. 
 
Visit the WinPAC Download Center: 
http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_ima
ges.htm 

 
The following update categories are available from the WinPAC Download Center.  
 OS images Includes updates and the latest version of WinPAC OS.  
 WinPAC SDK Includes updates and the latest version of each WinPAC component 

SDK, such as WinPAC SDK, NAPOPC_CE5 SDK, Modbus SDK, etc.  
 Utility & Tools Includes updates and the latest version for WinPAC toolkits  
 Demo Includes all related WinPAC demos.  
 Documents Includes updates and the latest version for related WinPAC documents.  
 System Disk Includes updates and the latest version for WinPAC toolkits 

http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm
http://www.icpdas.com/products/PAC/winpac/download/winpac_8000/download_os_images.htm
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Appendix A. Frame Ground 

Electronic circuits are constantly vulnerable to Electro-Static Discharge (ESD), which 
become worse in a continental climate area.  Some I-7000 ,M-7000 and I-8000 series 
modules feature a new design for the frame ground, which provides a path for bypassing 
ESD, allowing enhanced static protection (ESD) capability and ensures that the module 
is more reliable.  
 
The following options will provide a better protection for the module:  
The I-8000 controller has a metallic board attached to the back of the plastic basket as 
shown in the Figure 2-1 below. When mounted to the DIN rail, connect the DIN rail to the 
earth ground because the DIN rail is in contact with the upper frame ground as shown in 
the Figure 2-2 below. 
 
 

 
 
 
 

 

 
Connect to the 
Earth Ground 

Frame Ground Attach to DIN Rail 
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Appendix B. Redundant Power 

The WinPAC provides two power inputs that can be connected simultaneously to live DC 
power sources. If one of the power inputs fails, the other live source acts as a backup to 
automatically support the WinPAC’s power needs. 
 
The WinPAC provides relay contact outputs to warn technicians on the shop floor when 
the power fails. 
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Appendix C. How to change the 
batteries 

RTC and SRAM data is retained by two Li batteries, which can supply continuous power to 
the 512 KB SRAM to ensure that the data is retained for 5 years. The dual-battery design 
has the added function of preventing data from being lost while replacing the battery. 

The following figures show the location of the tow batteries installed in the WinPAC. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Checking the current battery power: 
1. Run the WinPAC utility and check the Battery1 and Battery2 fields that display the 

current status of each battery. Refer to Section 3.5 WinPAC utility “System Settings Tab” for 
more details. If the power level for either of the batteries is low, both should be replaced. 
Note which battery has the lowest power level. 
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2. When programming this, call the pac_GetBatteryLevel() API function in the 
PACSDK.dll to check whether the battery power is low. When the power for either of the 
batteries is low, it’s recommended that the battery is replaced immediately, otherwise the 
data on the SRAM may be lost or RTC time will be reset. 

Note: 

The battery initial voltage should be around 2.8~3.0V, when below 2.1V, the 
WinPAC/ViewPAC Utility will show the low power warning. When below 1.5V, the data 
in the RTC (real time clock) and 512KB SDRAM will be lost. 

1 Replacing the battery without losing data 
1.1 Power off the WinPAC device. 
1.2 Remove the cover of the module inserted into the slot. 
1.3 First, remove the battery that is running low on power from the battery holder.  
1.4 Insert a new battery. 
1.5 Remove the other battery. 
1.6 Insert a new battery. 

Notes: 
1. If the battery power for only one of the two batteries is low, you can use this 

method to replace the battery so as to prevent data from being lost. (In the circuit 
design for the WinPAC series, When the power for one of the batteries is low, it 
will automatically switch to the other one to ensure continued battery power) 

2. If both batteries have run out of power, the data will be lost, even if this method is 
used to replace the batteries. 

2 Replacing the battery – 2 
Back up the SRAM data using a backup utility before replacing the battery. Refer to 
Section 2.8 “Using the Backup Utility to back up the settings and files” to back up and 
restore the SRAM data. 
2.1 Run the backup utility to back up the SRAM data. 
2.2 Power off the WinPAC device. 
2.3 Remove the cover of the module inserted into the slot. 
2.4 Remove both batteries from their respective holders.  
2.5 Insert two new batteries. 
2.6 Power on the WinPAC device. 
2.7 Run the backup utility to restore the SRAM data. 
2.8 Set the RTC time. 

 
Ordering information 
Battery type: BR1632 (Part number is 2LB010 for ICP DAS) 
For more detailed information, contact your local sales office or distributor. 
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Appendix D. I-8K and I-87K Modules 

There are 1/4/8 slot options to expand local I/O. And the I/O modules can be parallel bus 
type (high profile I-8K series) and serial bus type (high profile I-87K series).  
 
The differences between I-8K and I-87K are listed below: 
 

Item I-8K Series I-87K Series 

Microprocessor No Yes (8051) 

Communication interface Parallel bus Serial bus 

Communication speed Fast Slow 

DI latched function No Yes 

Counter input (for digital input module) No Yes (100 Hz) 

Power on value No Yes 

Safe value No Yes 

Programmable slew-rate for AO module No Yes 
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Appendix E. Application of RS-485 Network 

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted–pair cables, 
if the RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be added to 
extend the RS-485 network. 
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E.1. Basic RS-485 Network 

The basic component of the RS-485 network consist of a Master Controller (or using a 
PC as a host controller), and some RS-485 devices. 
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E.2. Daisy Chain RS-485 Network 

All RS-485 devices are wired directly to the main network, If the network is up to 1.2 km, 
it will need a repeater (7510 series) to extend the network length. 
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E.3. Star Type RS-485 Network 

There are branches along the main network. In this case, it is better to have a repeater 
to isolate or filter the noise that is made by devices. 
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There is a better choice to use 7513 as a RS-485 hub on start type network. 
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E.4. Random RS-485 Network 

There are branches along the main wire. In this case, it is better to have a repeater to 
isolate or filter the noise that is made by devices. 
 
 

 
 
 



 

WinPAC 8000 User Manual, version 2.0.9   Last Revised: January 2014   Page: 181 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved.  ∗ E-mail: service@icpdas.com 

 

 

 



 

WinPAC 8000 User Manual, version 2.0.9   Last Revised: January 2014   Page: 182 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved.  ∗ E-mail: service@icpdas.com 

 

 

E.5. Master/Slaves Settings 

The RS-485 network based on master-slave architecture consists of a single master 
device and one or more slave devices. 
 
The WinPAC provides two RS-485 communication interfaces based on the 
master-slave system architecture, all of which have a pull-high/pull-low resistor, user 
can set it to master or slave for implementing an RS-485 multi-drop network. 
 
One of the RS-485 communications, COM2, its pull-high/pull-low resistor located on 
power board, the other, COM3, located on the right side and its pull-high/pull-low 
resistor located on the bottom of the right side, as shown below. 
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E.5.1. WinPAC as a Master (default): 

When one of WinPAC is set to master, then all the other devices on the same 
network must be slave mode. If the network is up to 1.2 KM, it will need a repeater 
(7510 series) to extend the network length. 
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When WinPAC as a master using COM2 communication interface, the 
pull-high/pull-low resistor located on the power board must adjust to enable as 
shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When WinPAC as a master using COM3 communication interface, the 
pull-high/pull-low resistor located on the power board must adjust to enable as 
shown below. 
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E.5.2. WinPAC as a Slave 

For most of application, when using one 7520 series as RS-232/485 converter, its 
pull-high/pull-low resistors are set to enabled. Then the WinPAC-8000 and all the 
other devices on this network must be slave mode (the pull-high/pull-low resistors 
must be disabled). 

If there are repeaters on the RS-485 network, there will be pull-high/pull-low 
resistors on both sides of the repeaters (I-7510) 
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When WinPAC as a slave using COM2 communication interface, the 
pull-high/pull-low resistor located on the power board must adjust to disabled as 
shown below. 

 

When WinPAC as a slave using COM3 communication interface, the pull-high 
/pull-low resistor located on the power board must set to “Slave” as shown below. 
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Appendix F. Tips – How to 

This chapter provides tips and a guided tour on using and maintaining the WinPAC. 
 
There are more FAQ documents on 
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/faq_in
dex.htm. 
 

http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/faq_index.htm
http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x_ce50/document/faq/faq_index.htm
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F.1. How to set up a telnet and FTP account to 
login WinPAC 

WinPAC Utility has an account management function that controls the user that has 
access into the telnet and FTP server.  
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F.1.1. Add a telnet and FTP account 

To establish a new telnet and FTP account, please perform the following steps: 
 

 

Step 1: Run the WinPAC Utility 
located on desktop 

 

Step 2: Select the Network Setting 
tab, and then select the Users and 
Password tab 

 
Step 3: Fill a user account in the 
User name and Password field, and 
then press Add button, the user will 

be added to the user account 
list 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 4: Press Setting button 
If the login succeeds, the dialog 
will display when the user 

The user will be 
added to the user 

account list 
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account has been created 
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F.1.2. Remove a telnet and FTP account 

To remove a telnet and FTP account, please perform the following steps: 
 

 

Step 1: Run the WinPAC Utility 
located on desktop 

 

Step 2: Select the Network Setting 
tab, and then select a user account 
from the user account list. The user 
account that you select will display 
in the User name and Password field 

 

Step 3: Press Delete button, the user 
will be deleted from the user 
account list  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 4: Press Setting button 
If the login succeeds, the dialog 
will display when the user 
account has been removed 

the User name and 
Password file will 

display the selected 
account 

Select a user 
account from the 
user account list 
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F.1.3. Use a Telnet to login WinPAC from PC 

To use telnet to login WinPAC from PC, please perform the following steps: 
 

Step 1: On the PC side, select Run from the start menu 

Step 2: Type cmd, and then press OK button 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 3: Type “telnet IP address” to connect to WinPAC 

 
 
 
 
 
 
 
 
 
 

 

1 

2. Type “cmd” 
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Step 4: Type user name and password to login 

 
 
 
 
 
 
 
 

Step 5: The connection has been established 

 

Tips & Warnings 

If you can’t login, please check that the FTP setting is enabled. 
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F.2. How to online debug WinPAC 

Debugging is a process that you use to find and resolve errors, or bugs, in a program. 
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F.2.1. Debug WinPAC programs in EVC++ 

Step 1: On the “Tools” menu, click “Configure Platform Manager…” 
command 
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Step 2: On the “Windows CE Platform Manager Configuration” dialog, click 
the “Properties…” button 

 

Step 3: On the “Device Properties” dialog, click the “Configure…” button 
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Step 4: On the “TCP/IP Transport Configuration” dialog, select the “Fixed 
port” check box, and then click the “OK” button 

 

 

Step 5: On the “Windows CE Platform Manager Configuration” dialog, click 
the “Test” button 
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Step 6: The “Manual Server - Action” dialog will appear displaying a 
command line, before click the “OK” button to close dialog, turn to 
the WinPAC controller side to do the next two-steps 

 

 

Step 7: On the WinPAC, select the “ Start” menu, and then click 
the “Run…” command  
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Step 8: On the “Run” dialog, type the command which displays in step 6 and 
then click the “OK” button 

 

 

Step 9: Return to the Host PC side, on the “Manual Server – Action” dialog, 
click the “OK” button 
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Step 10: On the “Testing Device Connection” dialog, click the “OK” button 

 

 

Step 11: On the “Device Properties” dialog, click the “OK” button 
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Step 12: On the “Windows CE platform or device to configure” dialog, click 
the “OK” button 

 

 

Step 13: On the “Build” menu, select the “Start Debug” command and then 
click the “Go” command 
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Step 14: The “Manual Server - Action” dialog will appear displaying a 
command line, before click the “OK” button to close dialog, turn to 
the WinPAC controller side to do the next two-steps  

 

 

Step 15: On the WinPAC, select the “ Start” menu, and then click the 
“Run…” command  
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Step 16: On the “Run” dialog, type the command which displays in step 5 
and then click the “OK” button  

 

 

Step 17: Return to the Host PC side, on the “Manual Server – Action” dialog, 
click the “OK” button 
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Step 18: On the “Manual Server - Action” dialog, click the “OK” button 
 

 

Step 19: Connection established. Then you can debug on line. 

 

Tips & Warnings 

If you want to quit the debugger and return to editing, you can click the 
“Stop Debugging “button from “Debug” menu 
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F.2.2. Debug WinPAC programs in Visual Studio 2005/2008 

Debugging in Visual Studio 2005/2008 are provided by WinPAC OS image V 
1.3.0.4 or later. 

 

Step 1: Make sure the following file are listed with the matching version 
numbers 

 

Path File 
C:\Program Files\Common Files\Microsoft 
Shared\CoreCon\1.0\Bin 

1. ActiveSyncBootstrap.dll 
2. ConMan2.dll 
3. ConManPS.dll 
4. DesktopDMA.dll 
5. eDbgTL.dll 
6. TcpConnectionC.dll 

C:\Program Files\Common Files\Microsoft 
Shared\CoreCon\1.0\Bin\1033 

conmanui.dll 

C:\Program Files\Common Files\Microsoft 
Shared\CoreCon\1.0\Target\wce400\armv4i 

1. DeviceDMA.dll 
2. eDbgTL.dll 
3. TcpConnectionA.dll 
4. clientshutdown.exe 
5. CMAccept.exe 
6. ConmanClient2.exe 

 

Step 2: If the version matches correctly and the entire file are there, copy the 
following files to WinPAC:\ System_Disk\ICPDAS\System folder 

 
 Clientshutdown.exe 

 ConmanClient2.exe 

 CMaccept.exe 

 eDbgTL.dll 

 TcpConnectionA.dll 
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Step 3: On the “Project” menu, click “[Project Name] Properties…” 
command 

 

Step 4: On the “SystemInfo*” tab, unselect “Deploy the latest version of 
the .NET compact Framework (including Service Packs)” check box 
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Step 5: On the “Tools” menu, click “Options…” command 

 

 

Step 6: On the “Options” dialog, select “PAC 270” from the “Show devices 
platform” list, and then click the “Properties…” button 
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Step 7: On the “PAC50- ARMV4:ARMV4I_Release Properties” dialog, click 
the “Configure…” button 

 

Step 8: On the “Configure TCP/IP Transport” dialog, select the “Use specific 
IP address” option and type the IP address of WinPAC, and then 
click the “OK” button 
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Step 9: On the “PAC50- ARMV4:ARMV4I_Release Properties” dialog, click 
the “OK” button 

 

 

 

Step 10: On the “Options” dialog, click the “OK” button 
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Step 11: On the WinPAC, run the “CommanClient2” and the “CMAccept.exe” 
applications which is located at: \System_Disk\ICPDAS\System 

 

 

Step 12: On the “Tools” menu, click “Connect to Device…” command 

 

 



 

WinPAC 8000 User Manual, version 2.0.9   Last Revised: January 2014   Page: 215 

Copyright © 2014 ICP DAS Co., Ltd. All Rights Reserved.  ∗ E-mail: service@icpdas.com 

 

 

 

Step 13: On the “Connect to Device” dialog, select “PAC 270” from 
“Platform” list and then click the “Connect” button 

 

Step 14: On the “Tools” menu, click “Connect to Device…” command 

 

 

Step 15: Connection established. Then you can debug on line. 
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FAQ: 
 

If the connection fails shown as follow, return to step 11 to do the action 
below 

 

 

Open the command prompt, run the 
“CommanClient2.exe/transport:tcpconnectiona.dll/property:port=5000/id:Con” 
at: \System_Disk\ICPDAS\System, and then run the “CMAccept.exe” 
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F.3. How to recompile WinCon programs 

To recompile Wincon programs to run on WinPAC, certain components of the programs 
require an adjustment that divides into two parts: 

 
1. Compiler old programs which ran on Wincon 8x3x and 8x4x 
2. Modify .vcp file to upgrade the old WinCon project 

 

Tips & Warnings 

In general, you only need to do part 1, after this, if the program still 
can’t be compiled to an application, the part 2 just need to do. 
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F.3.1. Compiler old programs which ran on Wincon 8x3x and 8x4x 

Step 1: Open project which programmed in WinCon using eMbedded Visual 
C++ 

 

Step 2: On the “Build” menu, click “Configurations” command 

 

 

 

Step 3: Make sure the CPU type is “STANDARDSDK” 
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Step 4: On the “Configurations” dialog, click the “Add…” button 

 

 

Step 5: On the “Add Project Configuration” dialog, choose one of the CPU 
type and then click the “OK” button. 
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Step 6: On the “Project” menu, click “Settings…” command 

 

 

Step 7: On the “Project Settings” dialog, select the “Link” tab and change 
the value of the “Entry-point symbol” field, “WinMainCRTStarup” to 
“wWinMainCRTStartup”, 
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Step 8: After performing above-mentioned steps, build the project, your 
project should build success. If not, it will show error message as 
follow. Please continue with the following steps 

 

Step 9: On the “Project” menu, click “Settings…” command 

 

 

Step 10: On the “Project Settings” dialog, select the “Link” tab and change 
the value of the “Project Options” field, “ARM” to “THUMB”, and 
then built the project  
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F.3.2. Modify .vcp file to upgrade the old WinCon project 

Step 1: Open a text editor to modify the .vcp file  
 

Step 2: In the .vcp file, replace “0xa301” with “0xa501” 
 

Step 3: In the .vcp file, replace “ARMV4” with “ARMV4I” 
 

Step 4: In the .vcp file, replace “MACHINE:ARM” with “MACHINE:THUMB” 
 

Step 5: Save the .vcp file just edited 
 

Step 6: Open the old WinCon project and recompile it 
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F.4. How to use the printer 

WinPAC have ability to access the printer, you can connect to the printer via Ethernet 
network or USB. 
 

Tips & Warnings 

WinPAC only supports HP Laser Jet Printers which support PCL6 
driver. The following printer support is released by HP 

 HP LaserJet 4000 series/HP LaserJet 4100 series 
 HP LaserJet 2100 series/HP LaserJet 2200 series 
 HP LaserJet 1200 
 HP LaserJet 3200/HP LaserJet 3300 
 HP LaserJet 4200 series/HP LaserJet 4300 series 
 HP LaserJet 5000 series/HP LaserJet 5100 series 
 HP LaserJet 8000 series 
 HP LaserJet 9000 series printers 

If you need the latest support of HP PCL6 printer, you can refer to 
following link 
http://h20000.www2.hp.com/bizsupport/TechSupport/Document.js
p?objectID=bpl04568 

 

http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568
http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568
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F.4.1. How to use network printer 

To use a shared network printer, please perform the following steps: 
 

Step 1: On the Host PC, check the name of the Host PC and the shared printer  
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Step 2: On the WinPAC, open a WordPad format file 

 
 
 
 

Step 3: Set up the printer 

1. Printer: PCL Laser 
2. Port: Network 
3. Net Path: \\ServerName\PrinterName 
The “ServerName” is your PC’s name or 
IP. 
The “PrinterName” is your printer’s 
shared name of your PC 

4. Paper Size: Select the paper size 
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F.4.2. How to use printer via USB 

To use a shared network printer via USB, please perform the following steps: 
 

Step 1: On the WinPAC, open a WordPad format file 

 
 
 
 

Step 2: Set up the printer 

1. Printer: Hewlett-Packard LaserJet 
2. Port: LPT1 
3. Paper Size: Select the paper size 
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F.5. How to use services tool 

The services tool can help you turn on, turn off and monitor the WinCE services. 
 

Step 1: Open a MS-DOS command prompt 

 

 
 
 
 
 
 

Type “cmd” 
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Step 2: List all services 
 

[Syntax] services list 
 

 

Step 3: Type the commands to configure service  
 

[Syntax] services stop <services name> 
For example, turn on the “FTP” service: 
services stop FTP0: 
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Tips & Warnings 

For more information about using services tool, you just type “services 
help” 
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Appendix G. Revision History 

Revision Date Description 
1.0 July 2008 Initial issue 
1.1 August 2008 Added more information about WinPAC Utility 

functions in section 3.5. 
1.2 August 2008 1. Added additional information on how to establish a 

new telnet and FTP in Appendix E. 
2. Added additional information on how to use 

services tool in Appendix E. 
1.3 August 2008 1. Added additional information on how to use 

network printer in Appendix E. 
2. Added additional information on how to use printer 

via USB in Appendix E. 
1.4 September 2008 1. Added additional information on how to 

automatically update the WinPAC-8000 SDK in 
Appendix E. 

2. Added additional information on how to manually 
update the WinPAC-8000 SDK in Appendix E. 

3. Added additional information on how to update the 
WinPAC-8000 OS image from file 

1.5 September 2008 Deleted WP-8041 information 
1.6.0 July 2009 1. Changed the name of the version of this manual.  

2. Moved the OS and SDK updates from the 
Appendix E to the Chapter 6. 

3. Added information about the multilingual interface 
changes in section 2.6. 

4. Added information about installing the touch panel 
driver in section 2.7. 

5. Added information about the Multi-serial port 
wizard function of the WinPAC Utility in section 3.5 

6. Added additional information about the revision 
history in Appendix F. 

1.7.0 September 2009 1. Added a section about the module selection in 1.2. 
2. Added information about the support of the printer 

driver in Appendix E.4 
1.8.0 October 2009 1. Modified the specification of the flash disk in 
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section 1.1 and 1.2. 
2. Deleted auto mdi/mdi-x or auto mdix to Ethernet 

port specification 
3. Added additional information about the support of 

the Micro SD socket in section 1.2. 
4. Modified the printer configuration in Appendix E.4 

1.9.0 October 2009 1. Added information about two new OS mode 
(DCON_CE and VCEP mode) in section 2.3. 

2. Replaced Quicker with NAPOPC_CE5 
2.0.0 November 2009 Added information about WP-8x3x series modules 
2.0.1 December 2009 1. Modified the WinPAC installation in section 2.1. 

2. Added information about the requirements of the 
WinPAC SDK in section 4.3. 

2.0.2 April 2010 1. Modified the specification of Dual Battery Backup 
SRAM feature in section 1.1. 

2. Added information about I/O Expansion Slots in 
section 1.2. 

3. Modified information about Operating Environment 
in section 1.2. 

2.0.3. July 2010 1. Modified information about the companion CD in 
section 1.5. 

2. Modified information about using Backup_Utility to 
back up the settings and files in section 2.8. 

3. Added information about WinPAC tools in chapter 
3. 

2.0.4. November 2010 1. Added information about a caution about using 
System_Disk in section 2.9. 

2. Added information about the FTP setting function of 
the WinPAC Utility in section 3.5.2 and E.1. 

2.0.5. February 2011 1. Modified information about the WinPAC overview in 
section 1.4. 

2. Added information about the specification of COM 
ports in section 1.4. 

2.0.6. February 2011 1. Added information about COM1, COM2 in section 
1.4. 

2. Added information about how to use the printer in 
appendix E.4. 

2.0.7. October 2012 Modified information about the WinPAC Platform 
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SDKs in chapter 4. 

2.0.8. July 2013 1. Removed I/O Module Hot Swap Ability in section 
1.1. 

2. Update WinPAC utility information in section 3.5. 
3. Added limitations for using Visual Studio in section 

4.1. 
4. Added demo programs and SDK library selection 

in section 5. 
2.0.9 January 2014 1. Added information about battery. 
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